Movie
Maestro

"Hollywood magic at a down-to-earth price"

Documentation
for

SmartSound® Movie Maestro™

Get the latest news from Sonic Desktop Software at http://www.smartsound.com



http://www.smartsound.com/

License Agreement

SONI C DESKTOP SOFTWARE, | NC. ("SDS') SOFTWARE LI CENSE AGREEMENT

CAREFULLY READ THE FOLLOW NG TERMS AND CONDI TI ONS BEFORE USI NG THI S SOFTWARE. BY
CLI CKI NG THE "ACCEPT®" BUTTON, YOU ARE ACCEPTI NG SUCH TERMS AND CONDI TIONS. | F YQU
DO NOT' W SH TO BE BOUND BY SUCH PROVI SI ONS, YOU SHOULD CLI CK "DECLI NE® AND
PROVPTLY RETURN THI S PACKAGE TO THE PLACE OF PURCHASE FOR A REFUND

1. Omership. The encl osed SDS software programand related instructions (the
"Software") are licensed (not sold) to you, and SDS retains all ownership
interests and intellectual property rights in the Software. Such ownership and
related interests are protected by US and international copyright [aws. You agree
to indemify, hold harm ess and defend SDS from and agai nst all clains or

l awsuits, including attorneys' fees, that arise or result fromany use or

di stribution of the Software (including the mnmusic/audio content) not expressly
aut horized in this Agreenent.

2. Software License. SDS grants you a nonexcl usive, nontransferable |license to use
the Software solely for your own personal use. You may not: (a) copy, disclose,
publish, export, distribute or sublicense; (b) renpbve any SDS trademarks or
copyright notices from (c) nodify, translate or prepare derivative works of; (d)
use in a conputer-based services business; (e) transmt over a network, by

t el ephone, or other electronic neans; or (f) reverse engi neer, deconpile or

di sassenble all or any portion of the Software in any form

3. Warranty. SDS warrants the Software nedia (e.g. diskettes) to be free from
defects in materials and workmanship for a period of sixty (60) days fromthe date
of purchase. SDS will replace any such defective nedia returned to SDS during such
warranty period, provided such defect is not the result of inproper use or

neglect, or if SDS is unable to do so, it will refund your price for such
defective Software. Replacenent (or refund) is the exclusive renmedy for any such
defects, and SDS shall have no liability for any other damages. THE FOREGO NG
WARRANTY | S IN LI EU OF ALL OTHER EXPRESS OR | MPLI ED WARRANTI ES, | NCLUDI NG ANY
WARRANTI ES OF MERCHANTABI LI TY OR FI TNESS FOR A PARTI CULAR PURPCSE. | N NO EVENT

W LL SDS BE LI ABLE FOR ANY KIND OF SPECI AL, | NCI DENTAL OR CONSEQUENTI AL DANAGES,

| NCLUDI NG LOST PROFI TS, EVEN I F SDS HAS KNOALEDGE OF SUCH POTENTI AL LGSS OR
DANVACGE.

4. Music/Audio Rights. You may adapt, synchronize, reproduce and distribute the
nmusi cal conpositions created with the Software and, if any, lyrics and other audio
included in or wwth the Software only for private viewing/listening or as part of
private, non-broadcast nultinedia works created, adapted or synchroni zed using the
Sof tware. Any performance or presentation for profit or other commercial use is
strictly prohibited. In addition, you agree to indemify and hol d harm ess SDS
fromall costs and expenses arising or resulting fromclains for royalties by
ASCAP, BM, SESAC or simlar performng rights societies or organizations for any
such unaut hori zed use of the nusical or audio content of the Software.

5. Educational Institutions. Notw thstanding the foregoing restrictions on use,
any educational institution or entity that qualifies for state or federa
educational funding shall be entitled to use the nusical conpositions created with
the Software and |yrics and other audio included in or with the Software for the
adm ni strative, educational and fundraising purposes of such qualifying
educational institution, such as (i) classroominstruction, teaching and tutoring,
(ii) reports related to school events and activities, student status and progress,



and institutional achievenents and acconplishnents, (iii) student enrollment (iv)
publicati on or broadcast of student nedia projects and general information
regarding the institution.

6. Term nation. This Agreenment is effective until termnated. You nmay termnate it
at any tinme by destroying the Software, including all conputer prograns and
docunent ati on, and erasing any copies residing on conputer equipnent. This
Agreenment also will termnate if you do not conply with any terns or conditions of
this Agreenment. Upon such term nation you agree to destroy the Software and erase
all copies residing on conputer equipnent.

7. Agreenent. This Agreenent expresses the entire understandi ng between you and
SDS, and supersedes all other oral or witten comunications relating to the
Software. This Agreenent shall be governed and construed under the |aws of the
State of California and subject to the exclusive jurisdiction of the courts

t herei n.

Federal |aw provides severe civil and crimnal penalties for the unauthorized
reproduction, distribution and exhibition of copyrighted nusic or audio tapes,
di scs or other nedia. Copyright infringenent is investigated by the FBI and may
constitute a felony with a nmaxi num penalty of up to five years in prison and/or
$250, 000 fi ne.
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Introduction

Congratulations on your purchase of SmartSound® Movie
Maestro™

SmartSound Movie Maestro brings your home movies to life by allowing you to easily
customize music to fit each scene in your movie--just like they do in Hollywood blockbusters.
Movies with a custom "score" (music soundtrack) are fun and interesting to watch and bring a
high level of emotional impact for the audience. Movies without music are just plain boring. With
Movie Maestro, you will be proud to show these movies to your friends and family.

Import almost any movie into Movie Maestro's easy to navigate interface, follow our easy 1, 2, 3
Maestro soundtrack "wizard" making simple selections from the options presented
and--viola--your movie has a perfectly edited music soundtrack. Nothing could be easier.

Our series of SmartSound Movie Music CDs feature great sounding music that will work with
your Movie Maestro software to give you an even greater number of choices when creating the
musical scores for your movies. Whatever kind of movies you enjoy making, there is a CD for
you: Family, Sports, Vacation, Blockbuster, Sentimental or Cutting Edge, all with plenty of high
quality selections for the types of projects you do. Thank you for purchasing SmartSound Movie
Maestro. Enjoy!



Installation

This chapter describes:

Hardware and Software Requirements

Installing Movie Maestro

Reqistering Movie Maestro

Installing Movie Music Libraries

Copying Sound Files to a Hard Drive

Hardware and Software Requirements

Following are the system requirements for Movie Maestro for Macintosh:

Mac OS 9.0+, including OS X
CD ROM drive
16 MB available RAM (24 MB recommended)

16 MB hard disk space minimum; 350 MB needed if you choose to copy all of the
included music to your hard disk

Apple's QuickTime version 5 or better
CarbonLib 1.4+

Installing Movie Maestro

The following describes how to install SmartSound Movie Maestro for Macintosh.

To install Movie Maestro:

1.

SLE R S N

Exit other Macintosh programs.

Insert the installation CD into your CD-ROM drive.
Double-click the Movie Maestro CD icon.
Double-click Movie Maestro Installer icon.

The Movie Maestro splash screen appears. Click Continue. The license agreement
appears. To print the license agreement, click Print.

Click Accept to continue the installation. The Destination Location box appears.



0 6 MovieMaestro Installer

Easy Install -

Click the Install button to install
* Easy Install
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- Quit
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7. The default location for installation is in the Applications folder. A folder is created called
Movie Maestro. You can modify the location by clicking on the Install Location drop-down
list and choosing "Select Folder". If choosing this option, find the folder where you'd like to
have Movie Maestro installed into, and click Choose.

8. Click Install to begin the installation. The installation begins.

9. The next screen allows you to automatically copy the sound files from the Movie Maestro
CD to your hard disk, so that you do not need to insert the Movie Maestro CD each time
you run the application. Approximately 350MB are required to copy the files. If you do not
want to copy the sound files at this time, click Don't Copy; otherwise, click Copy Now.
This will take a few minutes, as the sound files are large.

10.When the installation is complete, the registration screen appears. If you are not
connected to the internet, connect now. Fill out the information, and then click Register.
This emails the registration to us.

11. Click Quit to close the installer.

Note: Movie Maestro needs to access sound files from a Movie Maestro library while it is
creating soundtracks. You can copy the sound files to a hard disk so that the CD is not required

each time the software is used.

The first time you run Movie Maestro you will be prompted for your name and serial number.
Your serial number can be found on the license sheet included in your Movie Maestro box. The
introduction and tutorial are run when you first run the program, so that you are familiar with the
Movie Maestro process for creating your music.



Registering Movie Maestro
Why Register?

The most important reason to register your SmartSound Movie Maestro software is so that we
can notify you when updates to the program are released. In addition, we will have your
information on file to allow for fast and accurate order processing and technical support
assistance. You will also be notified via e-mail when new music libraries are released, so you
are aware of available royalty-free music and sound effects that can be integrated into your
SmartSound Movie Maestro system.

Technical support assistance is only available to registered users of Movie Maestro.

Installing Movie Music Libraries

When Movie Maestro is installed, the Movie Music included with the program is installed
(although it is not copied to your hard drive automatically). If you have purchased any additional
Movie Music CDs, you need to install them into Movie Maestro, so that the music is available
when you run the Add Music feature. Each library contains multiple selections of music that you
can access from the Maestro; the more libraries you install, the more music selections you will
have available.

If you have Movie Maestro running and add a new Movie Music CD into your computer's CD
drive, the installation window appears automatically. Otherwise, just follow the simple
instructions below to install your Movie Music CD.
To add a library manually:

1. Insert the appropriate Movie Music library into your CD drive.

2. On the Edit menu, click Librarian (OS 9.x), or select Librarian from the Movie Maestro
menu (OS X).

Click Add.
Locate and click the Movie Music library.
Click Open.

Locate and open the Library Enablers folder, and then click to highlight the file located in
this folder. (The name of the file will be the same as the Movie Music library.) Click OK.

The library is now listed in the Libraries box and the pieces of music from the library will
appear as selections within Movie Maestro.

o 0w
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The sound files are stored on the Movie Music CD. Movie Maestro prompts you for
the appropriate CD as you select music. You can copy the sound files to your hard
drive, so Movie Maestro will not need the CD. See below for copying instructions.

For more details on working with the Librarian, see the Adding More Music chapter.




Copying Sound Files to Your Hard Disk

Movie Maestro needs to access sound files from the appropriate Movie Music library while it is
creating soundtracks. With the Librarian, you can copy the sound files to your hard disk so the
CDs are not required.
To copy sound files to your hard disk manually:

1. Insert the Movie Music library that you want to copy the files from into your CD drive.

2. Open SmartSound Movie Maestro.

3. On the Edit menu, click Librarian (OS 9.x), or select Librarian from the Movie Maestro
menu (OS X).

4. In the Libraries list, click the appropriate Movie Music library. Click the Properties button,
located at the lower right hand corner of the window.

5. Highlight the track(s) that you want to copy.
6. Click Copy Selection to Drive.

For more details on copying files, see Copying Sound Files to a Hard Disk in the
Adding More Music chapter.




Quick Start

Are you already familiar with SmartSound programs, or familiar with lots of software programs?
Below are steps to walk you through the Movie Maestro soundtrack creation process. The
tutorial also shows you an overview of the Movie Maestro creation process; just click the
Tutorial button to view the step-by-step work flow.

Here are the basic steps for using SmartSound Movie Maestro to score your movie:

1.

Run Movie Maestro. At the Introduction window, select Create music for a movie and
click OK. The Choose Movie search window appears.

Locate your movie and Open. The movie is displayed in the Movie Viewer. (Note: We
can't read iMovie files directly into Movie Maestro. Save your iMovie as a QuickTime file
first, and open the QuickTime file.)

Click the Add Music button. Choose the soundtrack use, style, and selection you want to
use for your movie. Click Finish to add the music to the Soundtrack Timeline.

Move the Smart Block of music along the Soundtrack Timeline to line up with the movie, if
needed.

Drag the beginning and ending points of the Smart Block to resize the block to play longer
or shorter. (For more specific control over your soundtrack, read the Scoring section.)

Select a different Variation of the soundtrack from the drop-down list, if desired.
Click Save Sound.

To save your soundtrack directly to an associated software program choose Save
Soundtrack to iMovie or Save Soundtrack to iPhoto, and click Save.

To save the soundtrack as an AIFF file, choose Save Complete Soundtrack and click
Save. To save the soundtrack together with the movie as a finished movie, for Setting
select Save Movie and Soundtrack. To save each piece of music on the Timeline as a
separate file, choose Save Each Smart Block in a separate file.

If you use iMovie or iPhoto, we have a detailed instruction sheet available to walk you through

using these programs with Movie Maestro. Once you are familiar with Movie Maestro, read the
instruction sheets for easy guides to scoring your projects.




Movie Maestro Sample Project

We have provided a sample project with the Movie Maestro software, so you can see a
demonstration of what soundtracks are possible with our program. A sample movie clip is
included.

From the Introduction window, select Open the sample project. The movie clip is displayed,
and three pieces of music are opened onto the Timeline. These are three separate soundtracks
created by the Maestro, using the Add Music button, to score different scenes of the movie.

Press the Play button to watch the video with the soundtrack.



Software Overview

Following is a detailed explanation of the Movie Maestro environment, including definitions of the
buttons and options available to you. A following chapter, Scoring Your Movie, describes the work flow
you'll follow to create a soundtrack with Movie Maestro. Scoring Your Movie gives you a step-by-step
process to follow to create your soundtrack; this chapter is for getting familiar with the screen layout and
with the various buttons in Movie Maestro.

The Movie Viewer

When creating a soundtrack, it's very helpful if you can try out music with your movie to make sure the
music fits your scene. So we've added a Movie Viewer to allow you to watch your movie within our
software. You don't do any movie editing here; you're just watching your movie so you can pick the right
musical accompaniment. (See Bringing Your Movie Into Movie Maestro for details regarding supported

movie file types.)

Hovie
i 4 %  Yalume
Play movie Current location Back and forward Movie's original
within movie buttons audio volume

When you have selected a movie to view, a play bar is available immediately below the movie so you
can watch your movie. Clicking the Play button plays the movie; clicking the same button again pauses
the movie. There are also Back and Forward buttons at the end of the play bar if you would like to scroll
through your movie. Or you can click and drag the play indicator to move to a new location in your
movie.

On the far right-hand side of the movie, a Movie Volume control adjusts the volume level of any existing
audio (such as narration or sound effects). The default will be to have the volume at full level. To lower
the volume, click and drag the Volume point down the scale.



If at any time you want to replace the movie you are watching, select Choose Movie from the File
Menu.

Playback Controls

Located in the middle of the window, the Playback Controls will play the soundtrack, along with your
movie (if present):

Skip back one Play from current Skip forward one
Smart Block location Smart Block
(Ctri+Laft Arrow) (Space) (Ctri+Right Arrow)

f / '

5

Play from start Stop
(W (Space)

The Soundtrack Timeline

The score for your movie is built along the Soundtrack Timeline. The soundtrack can contain one piece
of music, or several pieces of music.
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To add music to the Timeline, click the Add Music button, located on the left side of the Timeline. This
launches the Maestro wizard, which helps you find the right music for your movie. When you have
completed the Maestro process, a Smart Block is added to the Timeline display, representing your
soundtrack.

The Remove button deletes the selected Smart Block(s) from the Timeline.

You can use the left and right arrow keys to move one frame at a time along the Timeline. Holding
down the shift key when using the left and right arrow keys moves 1/2 second at a time along the
Timeline.

The Timeline defaults to a display of 5 second intervals. Using the Zoom Control at the lower left, you
can zoom in and out on the Timeline. Your current location on the Timeline is represented by the yellow
Play Indicator. New music will be added where the play indicator is currently located; the time location
of the play indicator is printed immediately right of the indicator, in MM:SS:FF format (minutes, seconds,
frames).

Each Smart Block has Beginning and Ending Resizers, which are small white blocks. Dragging these
white blocks will lengthen or shorten the soundtrack on the Timeline, automatically reediting your music,
professionally, to the new time length. To the right of the zoom control is Source file name, indicating
the source piece of music for the highlighted block. Immediately below that is the Variation drop-down
list. If Movie Maestro is able to make more than one arrangement of the source music to the length of
the Smart Block, the alternate arrangements are listed here. Choose another arrangement from the drop
down list to try it out with your movie.

To the right of the Source listing is the Start Time and the Length Time. The Start Time indicates at
what point on the Timeline the selected block begins, in MM:SS:FF format (minutes, seconds, frames).
The Length Time represents the total time length of the highlighted block.

To the right of the time displays are the Fade In and Fade Out check boxes. Movie Maestro will create



Smart Blocks that are musically correct, with natural fades. However, if you would like the music to fade
in or fade out, just select the block and check the appropriate box, and a fade will be applied to the
block.

The overall volume of the block can be adjusted using the Block Volume slide bar. Select the Smart
Block and move the block volume locator until you have adjusted the volume to the desired point.
Moving the slide bar to the right will increase the volume; moving to the left will lower the volume.

The Track Volume, located to the right of the Timeline, will adjust the volume for the entire soundtrack.
Moving this bar up will increase the volume; moving down will lower the volume.

Just to the right of the Block Volume is a shortcut icon which, when dragged to your desktop, performs
an automatic export of your soundtrack. Just drag this icon to your desktop, and your soundtrack is
saved as an AIFF file, saved with the same sound quality as the source music.

What Are Frames?

Movies are composed of many different frames which, when run together quickly, form what appears to
be a moving picture. Movies are typically played at 24, 25, or 30 frames per second. Many of the
controls in Movie Maestro are designed to work accurate to the frame; this is why the time length is
displayed in minutes, then seconds, then frames (MM:SS:FF). So, 2:34:15 means 2 minutes, 34
seconds and 15 frames. If you are displaying at 30 frames per second, 15 frames is 1/2 a second. This
is also why the arrow keys will move so slowly through your movie; the arrow keys will move one frame
at a time. By displaying the frame as well as the minutes and seconds, we allow you to create a
soundtrack that is edited as precisely as possible to match your movie.

Command Buttons

To the left of the Movie Viewer are three buttons: Save Soundtrack, More Music, and Tutorial.

E The Save Sound button allows you to save your soundtrack.
j See the Saving chapter for complete details regarding your

Save Seund | [Save options.

The More Music button allows you to preview add-on music,
ﬁ when you are ready to add music to your Movie Maestro

,H system. We have a variety of CDs available for addition to
More Music | [your Movie Maestro system. You can also order the CDs
using the link to our web site.

_ % The Tutorial button runs a tutorial of Movie Maestro.
; Tuterial




Bringing Your Movie Into Movie Maestro

As you create your movie in your video editing software program, the movie is typically saved in
a special (proprietary) format that only that program can understand (typically called a "project
file"). Think of it like a word processing document. If you create a document in Appleworks, that
document is in a special Appleworks format, that cannot be read directly by other software
programs. The same is true with your movie. We cannot read your movie directly from a
program such as iMovie, since the movie is not in a format we can understand. But there's an
easy way to fix this.

Video editing software programs each have ways to export your movie, so it can be saved in a
different file format. There are many different types of file formats; Movie Maestro can read
many of them. Movie Maestro can import any movie file that can be read by Apple Computer's
QuickTime Player. Common formats that Movie Maestro can read include QuickTime, AVI, and
DV. For a complete list of the exact file formats that are readable, please visit QuickTime's web
site:

http://www.apple.com/quicktime/specifications.html

Once you have exported your movie into one of these file formats, you're ready to open it in
Movie Maestro. If you are using iMovie, then you can use the QuickTime option from iMovie to
save your video.

Note: You are only watching the movie in our program, not making any changes to it. This
exported file may be deleted once you have completed the score and finished your movie.

Setting the Frame Rate

You have three options for the Frame Rate displayed in the Timeline: 30 FPS (NTSC), 24 FPS
(Film), and 25 FPS (PAL). This only affects how times will be displayed and does not affect the
actual frame rate of your movie. 30 FPS is the default when the application is installed. To
change the frame rate, select Preferences from the Movie Maestro menu (OS X), or from the
Edit menu (OS 9.x). There is a Display Frame Rate drop-down list ; select the appropriate
frame rate, then click OK.


http://www.apple.com/quicktime/specifications.html

Scoring Your Movie

This chapter describes the work flow to follow to complete a score for your movie. If you are not
yet familiar with the screen layout of Movie Maestro and the function of the various buttons on
the screen, we recommend you review the Software Overview chapter before proceeding.

When you launch Movie Maestro, the Start screen appears (unless you have chosen to turn it

off):

Smartsound Movie Maestro Start

EEH Creaate music for a movia

|
ﬁ; Create music without a movie

|
| .i| Open a saved project

| 0 th I ject
| ‘ﬁ| pen the sampla projec

W show this box : Close

. If you have a movie ready to score, select the first option, Create music for a movie.
You'll be able to watch your movie and create a score that fits musically to the visuals.

« If you would like to create a soundtrack without bringing in a movie, select Create music
without a movie. You can create a soundtrack of any length, which can then be added to
your movie.

« As you're creating a soundtrack, you can save your work as a Movie Maestro Project,
which can then be edited later if there are changes that need to be made to the
soundtrack (so that you do not have to start over from scratch). The Open a saved

project option allows you to open up a previously saved project.

o Open a sample project displays a complete project, including a movie as well as
soundtracks that match the movie.

« Close Movie Maestro exits the application.



Saving Projects

Before beginning explanations of each scoring option, it's helpful to know how to save your
work as you go along, in case you want to continue working on your project at a later time. To
do this, you use the Save Project option. The File menu Save Project and Save Project As
commands allow you to save your project to your hard drive in Movie Maestro format. Only the
Save Project option will save in Movie Maestro format. The Save Soundtrack option is used to
create a sound file with soundtrack in it for use in other applications.

To save a project:
1. On the File menu, click Save Project. The Save dialog box appears.

2. Click the drive and folder where you want to save the sound file.
3. Enter a name for the sequence in the Name box.
4. Click Save.

To reopen the project at a later time, see below.

Opening a saved project

If you have saved a project in Movie Maestro format (using the File, Save Project or Save
Project As commands) and you want to reopen that project, you can do so from the File menu.

Select File, Open Project. The Macintosh search screen appears. Select your project and click
Open. The project is then loaded into Movie Maestro in its saved state.

If the project was recently used, it will also be listed in the Recent Projects list in the File
menu. You can also open the project by selecting it from this list, if present.

Create Music for a Movie

Note: For this option, you need to have a movie file prepared in a readable file format. If you
have not yet done so, consult the Bringing Your Movie into Movie Maestro chapter for an

explanation.

When you select this option from the Introduction Screen, the Choose Movie search screen
appears:
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Locate and Open your movie. Your movie opens into the top section of Movie Maestro. You
can play the movie using the Play button if you'd like to preview the movie before you begin the
scoring process. You can also adjust the volume of any preexisting audio using the Movie
Volume level on the right.

Now you're ready to start scoring your movie. Position the yellow play indicator on the Timeline
to where you want the first piece of music to begin. If you want music to start at the very
beginning of the movie, just press the Return key, which moves the play indicator to the
beginning. Otherwise, just click and drag the play indicator to the starting point where you
would like your music to begin. The left and right arrow keys will move one frame at a time
along the Timeline, to help you maneuver to a precise starting point. Hold down the Shift key
and press the left and right arrow keys to move 1/2 second at a time.

Once you're in position, click the Add Music button:

arl

. Add Music

This launches the Maestro, a wizard that will guide you through choosing your music:
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There are many ways to create a soundtrack using the Maestro. There are six categories
displayed: Blockbuster, Cutting Edge, Family, Sentimental, Sports, and Vacation. Choose one
of these categories and the Maestro will help you find suitable music. You can also select by
Style, Library, or Title. The options are described in more detail below. Note: If you have
installed any SmartSound Palettes, scene type categories may also be listed in the Maestro.
The categories below pertain to the Movie Maestro music and the Movie Music add-on
Palettes.

HINT! You can use the Up and Down Arrow keys to select from any list in the Maestro. You
can then use the Enter key to select Next.

Select by Style
You can Select by Style, rather than by scene type, if you already have a style of music in
mind. Use the Select by Style button to choose from various musical styles, such as

Jazz/Fusion or Rock. If you use this option, you’ll see a screen with various selections based
on musical style.

Select by Library
You also have the option to Select by Library. This option is necessary only if you have




purchased additional SmartSound Movie Music libraries, and want to view all the selections on
only one of these CDs. If this choice is selected, Screen 2 will list each Movie Music library you
have installed, and Screen 3 will list each piece of music on the CD selected.

Select by Title

Already know the title of the track you want to use? If so, you can use the Select by Title option.
Screen 2 then asks you to pick the section of the alphabet the title starts with, and the tracks
from that section of the alphabet are then listed.

Select by Category

The most common way the Maestro is used, however, is by selecting a category on Screen 1:
Blockbuster, Cutting Edge, Family, Sentimental, Sports, and Vacation. When this is selected,
Screen 2 then asks you to select a style of music.
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For example, if we want to add some Sentimental music, we have the option of choosing
Classical or New Age/Easy for our type of Sentimental sequence. Listings on Screen 2 change
based on how many Movie Music libraries have been installed.

When you then proceed to Screen 3, the Maestro will automatically search the music available
and list only those pieces of music which match your criteria.
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Preview the tracks listed to find the piece you want to use. To preview, select a particular track
(using the mouse, or using the Up and Down arrow keys) and press Play (the right-pointing
arrow below the track names). A preview of this piece of music will play for you.

If you have copied SmartSound music to your hard drive, the music will begin playing
immediately. Previews may not be available if you have not copied music to your hard drive
and the Movie Maestro CD is not on-line. If Movie Maestro cannot play a preview, you will be
prompted for the appropriate CD.

HINT! The music you are looking for may be listed under a different category than you think.
If you don’t hear the type of music you want, use the Back button to select a different style.

Click Finish and a Smart Block is added to the Timeline, representing your soundtrack. The
length of the block will be the same length as your video.

Modifying/Moving the Smart Block music

Once the Smart Block is on the Timeline, you can adjust the length, if necessary, by dragging



the small white blocks on either end of the Block. You can also move the entire block by
dragging the block along the Timeline to a new location. Use the Zoom slide bar to see more or
less of the Timeline to assist you in moving or adjusting the blocks.

If you need to move a Smart Block on the Timeline to a new location, first set the yellow play
indicator to the location where the block will begin playing. Use the left and right arrow keys to
move frame by frame through the movie to have the play indicator at the precise location, and
hold the Shift key while using the left and right arrows to move 1/2 second at a time through the
movie. Once the play indicator is set, then click and drag your Smart Block to that location. A
"ghost indicator" marks the location where the play indicator was located, and will "snap" the
Smart Block to the new location.

If you need to resize your Smart Block to a different size, you can set the play indicator to the
precise new starting or ending point as well. When you drag the resizer point on the Smart
Block, the block will "snap” to the new location and resize the block to begin or end at the point
where the play indicator was set. Or you can use the Set Start Point and Set End Point
options from the Soundtrack menu. These options will move the starting point or ending point
of your music block to the current location of the play indicator.

When the Smart Block is created, an arrangement of the music is made to the precise length of
the Block. This is a musically complete piece, just as a composer would create it. There is a
good musical beginning and a good musical ending to the piece. However, Movie Maestro can
usually create more arrangements for the music, which are also precisely edited to the desired
length. Select the block on the Timeline, then select from the Variations drop-down menu to try
out other soundtrack options, until you find the one you like the best.

The Smart Block will have a musical beginning and ending. You can add a Fade In or Fade Out
on the block, if desired. With the block selected on the Timeline, simply check the boxes below
the Timeline to activate these features.

Setting Music Start and End Points

The default time length for new Maestro blocks is the length of your video (or 30 seconds, if no
video is present.) You can then resize the block if you need the music to play for a different
length of time. If you prefer, you can set start and end points on the Timeline before selecting
the Add Music button. This way, you can set exactly where you want the music to start and
end before you add it to the Timeline.

To set the start point, just move the play indicator on the Timeline to where you'd like the block
to begin. Remember, you can use the arrow keys and the shift+arrow keys to move to the exact
starting location. Then click Set Start Point from the Soundtrack menu (or press Up Arrow).
A marking block is set on the Timeline, extending the block to the next block found, or to the
end of the video. If you want to have the music end sooner, you can set the end point as well.
Just set the play indicator to the correct location, then click Set End Point from the
Soundtrack menu (or press Down Arrow). When the marking block is set, click the Add
Music button to score that scene in your movie. The music that is added will take up just the



length of time you have marked off on the Timeline.

Volume Adjustments

You can optionally adjust the volume of a selected block using the Block Volume slide bar. The
volume will be adjusted for that block only; any other blocks on the Timeline will retain their
original volume.

Volume for the entire soundtrack can be adjusted using the Track Volume to the right of the
Timeline. Move the slide bar to adjust the volume to the desired level.

Adding Additional Music

You can add additional pieces of music along the Timeline until your entire movie has been
scored. To add a new track, just position the yellow Play Indicator on the Timeline where you
would like a new piece of music added, and click the Add Music button. You can add as many
different pieces of music along the Timeline as desired. If you want music to start at the very
beginning of the Timeline, just press the Return key, which moves the play indicator to the
beginning. Otherwise, just click and drag the play indicator to the starting point where you
would like your music to begin.

The next chapter, Saving, lists the various ways you can now save your completed soundtrack,
for use with your movie.

Create Music Without a Movie

When you select this option from the Start Screen, the Maestro will launch automatically (this is
just like clicking the Add Music button). The Maestro is a series of screens that guide you
through choosing your music.
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There are many ways to create a soundtrack using the Maestro. There are six categories
displayed: Blockbuster, Cutting Edge, Family, Sentimental, Sports, and Vacation. Choose one
of these categories and the Maestro will help you find suitable music. You can also select by
Style, Library, or Title. The options are described in more detail below. Note: If you have
installed any SmartSound Palettes, scene type categories may also be listed in the Maestro.
The categories below pertain to the Movie Maestro music and the Movie Music add-on
Palettes.

HINT! You can use the Up and Down Arrow keys to select from any list in the Maestro. You
can then use the Enter key to select Next.

Select by Style
You can Select by Style, rather than by scene type, if you already have a style of music in
mind. Use the Select by Style button to choose from various musical styles, such as

Jazz/Fusion or Rock. If you use this option, you’ll see a screen with various selections based
on musical style.

Select by Library
You also have the option to Select by Library. This option is necessary only if you have
purchased additional SmartSound Movie Music libraries, and want to view all the selections on




only one of these CDs. If this choice is selected, Screen 2 will list each Movie Music library you
have installed, and Screen 3 will list each piece of music on the CD selected.

Select by Title

Already know the title of the track you want to use? If so, you can use the Select by Title option.
Screen 2 then asks you to pick the section of the alphabet the title starts with, and the tracks
from that section of the alphabet are then listed.

Select by Cateqgory

The most common way the Maestro is used, however, is by selecting a category on Screen 1:
Blockbuster, Cutting Edge, Family, Sentimental, Sports, and Vacation. When this is selected,
Screen 2 then asks you to select a style of music.
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For example, if we want to add some Sentimental music, we have the option of choosing
Classical or New Age/Easy for our type of Sentimental sequence. Listings on Screen 2 change
based on how many Movie Music libraries have been installed.

When you then proceed to Screen 3, the Maestro will automatically search the music available
and list only those pieces of music which match your criteria.
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Preview the tracks listed to find the piece you want to use. To preview, select a particular track
(using the mouse, or using the Up and Down arrow keys) and press Play (the right-pointing
arrow below the track names). A preview of this piece of music will play for you.

If you have copied SmartSound music to your hard drive, the music will begin playing
immediately. Previews may not be available if you have not copied music to your hard drive
and the Movie Maestro CD is not on-line. If Movie Maestro cannot play a preview, you will be
prompted for the appropriate CD.

HINT! The music you are looking for may be listed under a different category than you think.
If you don’t hear the type of music you want, use the Back button to select a different style.

Click Finish and a Smart Block is added to the Timeline, representing your soundtrack. The
length of the block will be the same length as your video.

Modifying the Smart Block music

Once the Smart Block is on the Timeline, you can adjust the length, if necessary, by dragging



the small white blocks on either end of the Block. You can also move the entire block by
dragging the block along the Timeline to a new location. Use the Zoom slide bar to see more or
less of the Timeline to assist you in moving or adjusting the blocks.

When the Smart Block is created, an arrangement of the music is made to the precise length of
the Block. This is a musically complete piece, just as a composer would create it. There is a
good musical beginning and a good musical ending to the piece. However, Movie Maestro can
usually create more arrangements for the music, which are also precisely edited to the desired
length. Select the block on the Timeline, then select from the Variations drop-down menu to try
out other soundtrack options, until you find the one you like the best.

The Smart Block will have a musical beginning and ending. You can add a Fade In or Fade Out
on the block, if desired. With the block selected on the Timeline, simply check the boxes below
the Timeline to activate these features.

Volume Adjustments

You can optionally adjust the volume of a selected block using the Block Volume slide bar. The
volume will be adjusted for that block only; any other blocks on the Timeline will retain their
original volume.

Volume for the entire soundtrack can be adjusted using the Track Volume to the right of the
Timeline. Move the slide bar to adjust the volume to the desired level.

Adding Additional Music

You can add additional pieces of music along the Timeline until your entire movie has been
scored. To add a new track, just position the yellow Play Indicator on the Timeline where you
would like a new piece of music added, and click the Add Music button. You can add as many
different pieces of music along the Timeline as desired. If you want music to start at the very
beginning of the Timeline, just press the Enter key, which moves the play indicator to the
beginning. Otherwise, just click and drag the play indicator to the starting point where you
would like your music to begin.

The next chapter, Saving, lists the various ways you can now save your completed soundtrack,
for use with your movie.



Saving

This chapter describes:
« Saving with or without movie

o Save shortcut

« Advanced Save options

Saving is the process where Movie Maestro converts your finished soundtrack into a common
sound file format that other programs can read and use in their software programs. There are
several saving options within Movie Maestro; this chapter explains your choices. You can save
your soundtrack with the movie to have a complete finished project, or you can save your
soundtrack without the movie if you then want to import your soundtrack into your movie editing
system. Movie Maestro also has built-in shortcuts to some popular programs; if you are using
one of the programs listed above, the shortcut will save several steps in the saving process.

For information about saving projects, click here.

If you use iMovie or iPhoto, we have a detailed instruction sheet available to walk you through

using these programs with Movie Maestro. Read the instruction sheet for an easy guide to
saving your projects.

Saving with or without movie

Movie Maestro allows you to save your soundtrack with or without your movie for use in
another software application, such as a video editing system. The save option converts the
SmartSound music into a common sound file format that other software applications will be
able to read.

To save, either press the Save Sound button, or from the File menu, click Save
Soundtrack/Movie. The save dialog box appears.



Save Soundtrack

_ Save Complete Soundtrack

A

Sound Quality CD-ROM (22k) 'y

The entire soundtrack you created will be saved in a single AIFF
22k file.

r Advanced Save... 1 . Cancel

There are five Save options available: Save Complete Soundtrack, save Movie and
Soundtrack together, save Each Smart Block in a separate file, save Soundtrack to
iMovie, and save Soundtrack to iPhoto. Clicking on the bar where "Complete Soundtrack" is
displayed above will bring up the list, where you can choose the save selection.
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Complete Soundtrack - use this choice to save all of the music on the Timeline as a
single sound file.

Movie and Soundtrack - use this choice to save the music and the movie together as a
finished project.

Each Smart Block in a separate file - use this choice to save all of the music on the
Timeline as separate sound files. Each Smart Block will be created as a separate sound
file on your computer.

Soundtrack to iMovie - use this choice to save your soundtrack directly to iMovie. The
music on the Timeline is saved and added automatically to your iMovie Track 2. Your
IMovie project is saved into the Movies folder and saved with "(original)" at the end of the
file name. The project is then reopened with the soundtrack added to Track 2. Note: if you
already have sounds on Track 2, the SmartSounds will overlap them. Just drag the block
to another location, if desired.

Soundtrack to iPhoto - use this choice to save your soundtrack directly to iPhoto (OS X
only). The music on the Timeline is saved and added automatically to your iPhoto music
list, and set as the default music choice.

You can then choose from three sound Quality options: CD-ROM, Audio CD, and Digital
Video.

CD-ROM (22Kk) - This is a lower sound quality than the other options. The format is



22kHz, which generates a smaller sound file that is good to use for CD-ROM or
multimedia applications.

Audio CD (44k)- This is the same quality as popular music CDs you purchase in a
store. The format is 44.1kHz.

Digital Video (48K) - This is the highest level of sound quality available, 48kHz.
Many video editing systems now use 48kHz as their recommended audio format for
movie making.

The source music that comes with Movie Maestro, as well as the Move Music CDs, are
recorded at 22kHz. You have the option to save in 44.1kHz and 48kHz formats, but the sound
quality will not increase. If you need professional-quality sound, we have a variety of
SmartSound Palettes available at our web site which are available at 44.1kHz quality. Just visit
http://www.smartsound.com/music for details. Once you have set the above options, you are

ready to click the Save button. (For Advanced Save options, see below.)

The Save Button

When you click the Save button, the Macintosh Save menu appears. This screen works like all
Macintosh save screens:

1. Locate the folder where you'd like your soundtrack to be saved. Click the drop-down list
next to Save in: (OS 9.x) or click the drop-down list next to Where: (OS X) to select a
different folder than what is currently displayed.

2. File name: (OS 9.x) or Save As: (OS X) Enter the name for your file.
3. Click Save to save the file.

Save Shortcut

There is a built-in save shortcut available, allowing you an option of saving your soundtrack
quickly to your desktop. While working in Movie Maestro, the shortcut icon appears just to the
right of the block volume. Dragging this icon to your desktop will automatically save the
currently selected block as an AIFF file on your desktop, called "variation.aif", where variation is
the name of the music variation that is currently on the Timeline. The sound quality format is
the same as the music placed on your Timeline; that is, if you are working with 22k sound files,
then the AIFF file created is in 22k format.

Advanced Save Options

When you click the Advanced Save button, an expanded Macintosh Save menu appears:
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This screen works like all Macintosh save screens:
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Locate the folder where you'd like your soundtrack to be saved. Click the drop-down list
next to Save in: (OS 9.x) or click the drop-down list next to Where: (OS X) to select a
different folder than what is currently displayed.

File name: (OS 9.x) or Save As: (OS X) Enter the name for your file.
Save as type: (OS 9.x only). All Files (*.*). This is the only choice.

Export: The Export drop-down list allows you to choose the export file format for your
soundtrack. You can export your soundtrack as a movie or sound file.

If you want to export the soundtrack as a sound file for use in another application, select a
format such as "Sound to Wave" or "Sound to AIFF". If you want to export the soundtrack
as a movie, select a format such as "Movie to QuickTime Movie".

Use: Choose a use from the Use drop-down list. The Use drop-down list in the Export
dialog box allows you to choose settings for your soundtrack dependent on the file format
chosen. You can choose to use the default settings, the most recent settings, or a
particular setting for the chosen format. For example, if you choose to export your
soundtrack as an AVI file, you can choose your CD-ROM speed or animation. If you
choose to export your soundtrack as a WAVE file, you can choose the kHz speed,
whether it is 8- bit or 16- bit, and whether to export as mono or stereo. Each file format
has choices relevant to that format.

6. Options button: When you click the Options button, you'll see the following screen:
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o Select the Video check box if you want to export your video with your soundtrack.
0 Select the Sound check box.

o Click Settings to adjust the sample rate, bit depth, stereo/mono and compression
settings.

o Click OK.
7. Click Save to save the file.



Adding More Music

In this chapter:
o Movie Music libraries

« Even More Music

o Installing new libraries: What is the Librarian?

e Accessing the Librarian

o Adding a Library

« Removing a Library

« Copying Sound Files to a Hard Disk

Movie Music libraries

SmartSound has a series of six Movie Music libraries which have been specially designed for
use with Movie Maestro. These CDs will add to the music selections in the Maestro, to increase
your available music choices. They have been specially priced for home and educational use,
and have formatted content so Movie Maestro will know how to edit the music to any time
length (and create multiple arrangements).

The library categories are: Vacation, Family, Blockbuster, Cutting Edge, Sentimental and
Sports. Previews of the Movie Music libraries, as well as ordering information, is available by

]

clicking the More Music button 2= | within Movie Maestro.

From this area, you can listen to previews of each of the Movie Music libraries. Just click on
one of the six pictures, which represent the six CDs. The samples will play for you
automatically, or you can click each of the buttons to hear the samples. Descriptions of each
music track appear as they play.

There is a How to buy button on the More Music page that links to the ordering page at our
web site. And there is Even More Music!, which links you to a location at our web site where

other SmartSound Palettes are available.

Note: Movie Music libraries are licensed for home use only, and have been specially priced for
home and educational use with no royalty payments necessary. If you need music for
commercial use, we have a wide range of SmartSound Palettes available which are royalty-free
for broadcast and commercial use. See below for details.



Even More Music

Sonic Desktop Software also has an extensive collection of Audio Palette, Sound Palette, and
Edge Series CDs which will also work with Movie Maestro. The Audio Palettes contain music,
and the Sound Palettes contain sound effects. The Edge Series contains special cutting-edge
styles of music, such as techno and rap, written especially for Sonic Desktop Publishing, which
can't be found through any other source. These CDs increase the list of selections in the
Maestro.

SmartSound Palettes come in two versions: Professional (44.1k), and Multimedia (22k). For a
complete listing and samples of our CDs, visit http://www.smartsound.com/music. To purchase
SmartSound CDs, call our sales line at (800) 454-1900, locally at (818) 718-9999 or visit our
web site at http://www.smartsound.com to order online.

Installing New Libraries

What is the Librarian?

The Librarian allows you to easily install, add, remove, and manage your SmartSound music
and sound effects. Each SmartSound library contains multiple music selections or sound
effects. Each SmartSound CD also comes with an index file that contains information about the
library, called the library enabler. When you install a SmartSound CD, the library enabler is
installed; Movie Maestro then knows to display the contents of that CD in the Maestro. The
sound files on the CD can also be copied to your hard drive, for quick access when creating
soundtracks.

Accessing the Librarian

You can access the Librarian by selecting Librarian from the Edit menu (OS 9.x) or selecting
Librarian from the Movie Maestro menu (OS X).
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appear as choices in the Maestro. The list of currenthy
) installed libraries is shown below.

! Library Mame - | Copied to drive

E Blockbuster Yes
|E Cutting Edge Yes
Yes
. Sentimental Yes
E Sports Partially
Vacation Yes

" Add... Remaove Properties

( one )

Under Library Name each installed SmartSound library is listed. Copied to drive indicates
whether each library has been copied to your hard drive. If all of the library has been copied,
"Yes" appears here. If part of the library has been copied it will display "Partially”, otherwise it
will read "No".

Adding a Library

In order to use SmartSound CDs, you must install each library into Movie Maestro. The more
libraries you add, the more selections available in the Maestro.

Adding a library is a very simple process with Movie Maestro; when you put a library into your
CD drive, the install program launches automatically. (If you don't have Movie Maestro currently
running, the install program appears when you launch Movie Maestro.) The Add SmartSound



Library window appears. If you are installing a Palette, select 22k or 44k, otherwise just click
Add Library. You then have the option to copy the library contents to your hard drive. If you
copy the files, you will not need to put the CD into the drive each time you want to use it. Each
Movie Music CD requires about 120 megabytes; SmartSound 22k Palettes are approximately
200 megabytes, and 44k Palettes require 400 megabytes. Click either Copy Now or Don't
Copy. (Files are copied to the Sound Files folder within the Movie Maestro folder on your hard
disk.) Your library will now appear in the Libraries list and will be available when you use the
Maestro.

Here is the manual method for adding a library:
1. Insert the SmartSound CD into your CD drive.
2. From the Edit menu (OS 9.x) or Movie Maestro menu (OS X), click Librarian.
3. Click Add. The Add Library window appears.

4. If you have a Movie Music CD, there is only one choice. If you have a SmartSound
Palette, choose either 44k or 22k. For example, if you purchased the 44k version of the
Scoring Essentials Audio Palette, click Scoring Essentials 44k. You are asked for an
unlocking code. This code is printed on the outside of the shrink-wrap of the SmartSound
Palette. Note: You do not need a unlocking code for 22k SmartSound CDs.

5. Click Add Library.

6. You have the option to copy the library contents to your hard drive. If you copy the files,
you will not need to put the CD into the drive each time you want to use it. Each Movie
Music CD requires about 120 megabytes; 22k Palettes are approximately 200
megabytes, and 44k Palettes require 400 megabytes. Click either Copy Now or Don't
Copy.

The name of the library now appears in the Libraries list.
Removing a Library

If you no longer would like a particular library installed, you may want to remove the library.
When you remove a library, any sound files which have been copied to your hard drive are also
removed.

To remove a library:
1. In the Libraries list, click the library that you want to remove.
2. Click Remove. A warning message appears indicating that you are removing a library.

3. If any selections have been copied to your hard drive, a checked box appears in this
window which will remove the selections from your hard drive. Make sure this box
remains checked so the selections are removed at the same time as the library; otherwise
you'll waste disk space.

4. Click Yes and the library is permanently removed from the Libraries list. The selections
contained in that library no longer appear in the Maestro or the SmartSound Browser.



Copying Sound Files to a Hard Disk

Movie Maestro needs to access sound files from the appropriate library while it is creating
soundtracks. You can copy the sound files to your hard disk so the CDs are not required.

Note: Disk space requirements for Movie Maestro CDs are approximately 120MB. Each 22k
SmartSound Palette is about 200MB. 44k Palettes need about 400MB of disk space each.

To copy sound files to your hard disk:

1. Insert the SmartSound CD into your CD drive.
2. From the Edit menu, click Librarian. The Librarian appears.

3. In the Libraries list, click the appropriate library.

Note: If the Palette does not appear in the Libraries list, use the Add command to
install the library.
4. Click Properties. The tracks for the selected Palette appear in the Selections list:

i_i-t;rar:n,f Prﬁpér‘ties

| Sports

— ___ Description

' High intensity tracks built for action-filled sports footage.
Selections from Music Bakery

Encoding: lan Dahlberg

22kHz v1.0
! Selection name ‘! Copied to drive

:;1 Olympic Fanfare Yes
:;'1 Overture Yeasg
=} Power Rock Racer Yes
=} Sports Flash Yes

Street Beat No .
| Texas Rock Yes v

10 selections in library, 2 copied to drive



f_ Done ‘

5. Highlight the track(s) you want to copy.
6. Click Copy selection to drive.

This may take several minutes to complete, as the sound files are large.



Shortcut Keys for Macintosh

General Controls

Cmd+0O Open Project

Cmd+ N New Project

Cmd+S Save Project (in Movie
Maestro format)

Cmd+Y Choose movie to import

Cmd+E Save soundtrack with or

without movie

Cmd+Q Exit
Cmd+L Librarian
Cmd +; Preferences
Cmd+Z Undo last command
cmd+ & +7 Redo last command
< = Shift key
Timeline
Cmd+M Launches Maestro / Add Music
Return Key Stops play, returns to zero on the
Timeline
Space Bar Play (except Maestro)/Stop
toggle




\

Play from beginning

Ctrl + <-- (Left Arrow)

Skip backward

Ctrl + --> (Right Arrow) Skip forward
Cmd+C Copy block
Cmd + X Cut / Remove soundtrack from
timeline
Cmd+V Paste block
[ Nudge block back one frame
] Nudge block forward one frame
Shift + [ Nudge block back 1/2 second
Shift + ] Nudge block forward 1/2 second

<-- (Left Arrow)

Move play indicator one frame to
the left

--> (Right Arrow)

Move play indicator one frame to
the right

Fo Move play indicator 1/2 second
to the left
¥ S Move play indicator 1/2 second
to the right
Double-click block Plays block
Up Arrow Set Start Point
Down Arrow Set End Point

< = Shift key




Instruction Sheet: Using Movie Maestro with
Apple's iMovie

Apple Computer's iMovie software enables you to make home movies quickly and easily, with
professional touches. SmartSound Movie Maestro works in conjunction with iMovie to add
music to your movie, precisely edited to each scene. There are three steps to creating a
professional soundtrack for your iMovie project:

o« Export a reference movie from iMovie to Movie Maestro

o Add music to your movie with Movie Maestro, and save your soundtrack directly into
iIMovie

« Create your finished movie in iMovie

Exporting a reference movie from iMovie to Movie Maestro

Step one is to bring your movie from iMovie into Movie Maestro, so you can watch it and decide
what music works best with each scene. From iMovie, select File, Export Movie.

Export Movie

— Export: | To QuickTime™ ey

g

Formats: Web Movie, Small '#

Video: H.263, size: 240x180, 12.00 frames per
second
Audio: QDesign Music 2, Stereo, 22050.00hz

"] Quicktime 3.0 compatible

" Cancel @

For Export: choose To QuickTime™ For Formats:, choose Web Movie, Small. Click Export.




Export QuickTime™ Movie !

Export QuickTime™ Movie

Save As: | [taly val:atlcln|.rnnv i

Where: |m Movies 'y m

 cancel Y £ Save )

Enter a name for your movie and choose the location where to save it. Click Save.

Do not exit from iMovie (you can hide the program using Cmd-H).

Add music to your movie with Movie Maestro, and save your
soundtrack directly into iMovie

Once your reference movie has been created, run Movie Maestro. Choose Create music for a
movie. The Choose Movie search screen appears. Locate and Open your reference movie.
Click the Add Music button to add music to your movie; drag the resizers to modify the time
length of the block, and choose the Variation of the music that works best for your scene. Move
the block along the Timeline so that it begins and ends at the proper locations. Add additional
pieces of music until all of the music for your movie is completed. (See the Scoring section for

detailed information about how to use add music.)

Click the Save Sound button. For Save: choose Soundtrack to iMovie.



Save Soundtrack

_Save | Soundtrack to iMovie v

The current soundtrack will be added into track 2 of an iMovie
project. A backup of the original project will be created. All
smartsound hles in the project can be replaced with the current
soundtrack by choosing the option below.

iMavie Project:

: I —
jcurrent project] Specify...

) Replace SmartSounds already in project

® Add SmartSounds to project

i . F 4 )
Advanced Save... Cancel ' Save... |

If you already have SmartSound music in your current iMovie project, you can choose to
Replace SmartSounds already in project, or Add SmartSounds to project. Choose the
appropriate action, and click Save. Movie Maestro switches to iMovie and adds the music from
the Timeline onto Track 2 of iMovie. The soundtrack is saved in your iMovie's Media folder,
using the Variation name of the piece of music selected. If you used more than one piece of
music, each piece is saved separately and added to your iMovie Track as separate pieces of
music.

Create your finished movie in iMovie

Now that your soundtrack is on Track 2, your movie is done! You are ready to Export your
movie as a finished movie, in the format you would like it to be.



Instruction Sheet: Using Movie Maestro with
Apple's iPhoto version 1.1

Apple Computer's iPhoto software enables you to make slide shows of your photos, for sharing
with your family and friends. Movie Maestro will create a background score for your slide
shows. Since iPhoto settings are the same for different slide shows, you won't necessarily need
a piece of music that is precisely timed. However, you can use Movie Maestro to create a new
piece of music that can be added to your slide show music list. You can also create a
QuickTime movie of your slide show that is precisely scored using Movie Maestro. Please note
that version 1.1 of iPhoto is needed,; visit http://www.apple.com/iphoto for update information.

Adding Music to iPhoto

If you are creating a soundtrack to play with various slide shows in iPhoto, then you will use the
Create music without a movie option from within Movie Maestro. Use the Maestro to select
the music to use. The default length of the soundtrack is 30 seconds. Zoom out on the Timeline
(by dragging the Zoom indicator to the left), then select the music block by clicking it with your
mouse. A resizer is displayed at the end of the block. Click and drag the resizer until the block
is the desired time length. Movie Maestro will rebuild the soundtrack arrangement to this new
time length automatically for you.

You can select a different arrangement of the music from the Variation drop-down list, if
desired. There is no need to add a Fade In or a Fade Out to the soundtrack, as it will have this
added automatically in iPhoto.

When your soundtrack is completed, click Save Sound. In the Save drop-down list, select
Soundtrack to iPhoto.


http://www.apple.com/iphoto

Save Soundtrack

__Save Soundtrack to iPhoto e

The current soundtrack will be added as a music option in

iPhoto's slideshow. iPhoto will quit if it is currently running.
The file will be saved in your "Documents/Movie Maestro/

iPhoto Music” folder.

= £ LY :
Advanced Save... L Cancel _ F!ﬂ’

Click Save. The new soundtrack is now loaded into iPhoto as the default Slide Show music.
(Note: If iPhoto is currently running, the iPhoto application will be restarted.)

Choose your Album in iPhoto, click Share, and click Slide Show to select what music is played
with your slide show.

The file is saved into the Documents folder on your hard drive. The file is saved in the same
rate as the source music; that is, if the source music is at 22kHz, the sound file is saved at
22kHz.

Saving and Scoring An iPhoto Slide Show as a QuickTime Movie

If you would like your slide show turned into a QuickTime movie, iPhoto and Movie Maestro
work together to create your movie and score the soundtrack precisely to the slide show movie
length.

First, you'll need to create a QuickTime movie of your slide show. From iPhoto, select the
appropriate Aloum. Click Share. The Share options are listed at the bottom of the window. Click
Slide Show and set the appropriate time length for each slide.



Slide Show Settings

Play each slide for . & @ seconds

E Repeat slide show

Music: | Soundtrack "':1

tf Cancel :" H-',

Click the Music drop-down list and select None. Click OK. The slide show is played for you;
click the mouse to stop the slide show. Then click Export from the File menu.

Export Images

[ File Export T Web Page uickTime

_Images

Width: 640

Height: 480

S—

Display image for 8.00 @ seconds

_ Background
@ Color |

O Image gy —

_ Music

"] Add currently selected music to movie.

4 photos t‘: Cancel :" [‘: Export :‘




Select the QuickTime tab. Enter the maximum width and height for your movie size, and make
sure the display image setting is correct for the number of seconds you would like each slide to
be displayed. You can then choose your background color or set an image as your background
image. Click Export. The save screen appears. Enter the name for your QuickTime movie, and
specify where you would like the movie saved on your computer.

Once your slide show movie is created, you're ready to add the music to your movie. Run
Movie Maestro, and select Create music for a movie. Locate and choose the slide show
movie and click Open. Click Add Music. Select the music you'd like to use with your slide
show. The music block is added to the Timeline, set to the time length of your slide show.
Select the Variation you like the best.

When your music is finished, click Save Sound. From the Save drop-down list, choose Movie
and Soundtrack. Click Save. Enter the name for your completed movie and indicate where
you'd like the movie saved. Click Save. Your QuickTime movie is now complete, and will play
your slide show with the music you created with Movie Maestro.



Frequently Asked Questions

Below is a list of frequently asked questions or issues. For an up-to-date list of FAQs, visit our
special Frequently Asked Questions web page. For technical problems, check the

Troubleshooting chapter.

« How can | create a soundtrack without bringing in my movie?

« What is the difference between Professional (44.1k) and Multimedia (22k) SmartSound
Palettes?

e« Can | use SmartSound music in my productions/products?

« How can | find out about updates to my Movie Maestro program?

o Can | create multiple tracks of music?

o« Can | edit my movie with Movie Maestro?

« Can | edit my own audio with Movie Maestro?

« How can | get more advanced features in Movie Maestro?

e | only want to score one scene of my movie, but the Maestro scores the whole thing. How
can | score just the area | want?

« How do | work with applications other than iMovie and iPhoto?

« Why are the soundtrack variations sometimes a slightly different length than | specify?

-- How can | create a soundtrack without bringing in my movie?

You do not need to have a movie in Movie Maestro to create a movie score. If you prefer, you
can use the timings in your video editor to determine the length for your soundtrack, then use
Movie Maestro to generate the necessary length. Just figure out the total time length needed

for your soundtrack (usually video editors have a way to see the start time and end time for a
particular scene) then use that calculation for the time length of your Smart Block.

--- What is the difference between Professional (44.1k) and
Multimedia (22k) SmartSound Palettes?

SmartSound Movie Music series of CDs is provided at 22k format, also considered multimedia
format. 44.1k and 22k refer to the sample rate of the source sound files that Movie Maestro
uses. The higher the sample rate, the better the sound quality. It mainly effects the way the
highest frequencies sound. Cymbals, bells, and other high frequency information is most
accurately reproduced at 44k. Audio CDs you buy in a store are at 44k. Many people producing
video tapes prefer the 44k sound.

SmartSound Audio Palettes, Sound Palettes, and Edge Series CDs come in two versions:
Professional (44.1k), and Multimedia (22k). These CDs, as well as the Movie Music line of CDs,
are available for use with Movie Maestro.


http://www.smartsound.com/redirect.pl?app,mm&location,support

The higher the sample rate, the larger the sound file. Files stored at 44k are twice as big as
files at 22k. 22k is more than adequate for multimedia type applications. Our 22k files are
enhanced for improved quality.

--- Can | use SmartSound music in my productions/products?

The music that comes with Movie Maestro as well as the SmartSound Movie Music palette
series can be used for your own, personal movie projects and for school use. They cannot be
included in any professional project, or any project that is sold or broadcast. Read the license

agreement for specific terms relating to the use of the music.

Our Audio and Sound Palette collection of CDs are available as royalty-free music available for
broadcast (as long as SmartSound music is used as part of a visual, narrative, or web site
production). You don't have to pay any additional money to us. However, you may be required
by the TV station to file cue sheets which credit the composer of the music you use. This is the
TV station's or TV network's responsibility and shouldn't cost you anything. The TV stations pay
a blanket license to play music on their shows.

--- How can | find out about updates to my Movie Maestro program?

If you registered your Movie Maestro software you will be automatically notified by e-mail when
updates are released.

You can also check Movie Maestro web site for the latest information, helpful hints, FAQs, and
updates (if necessary).

--- Can | create multiple tracks of music?

Movie Maestro is a single-track system. Since SmartSound music is fully produced, no building
of multiple layers of instruments is required. Any advanced layering of sound effects and
narration over the music should be performed in your movie editing system.

--- Can | edit my movie in Movie Maestro?

Movie Maestro is designed as a soundtrack creation tool. We do not offer movie editing
software. We do allow you to view your movie while you're scoring it, and you can save the
resulting soundtrack with the movie.

--- Can | edit my own audio with Movie Maestro?

Movie Maestro is designed to work with SmartSound music only. We have a variety of libraries
which are specially encoded to work with our software, so the music can be edited to any time
length you need it to be to fit your movie. See the Adding More Music chapter for complete

details regarding additional music for your program.
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--- How can | get more advanced features in Movie Maestro?

Sonic Desktop Software, makers of SmartSound Movie Maestro, also make SmartSound
Sonicfire Pro, a more advanced program for video editors. As your productions become more
advanced, you may want to consider purchasing Sonicfire Pro to add additional features to your
soundtrack creation process. All of your Movie Maestro music will work with Sonicfire Pro, and
you can even open Movie Maestro project files into Sonicfire Pro! For more information about
Sonicfire Pro, visit http://www.smartsound.com/sonicfire.

--- | only want to score one scene of my movie, but the Maestro
scores the whole thing. How can | score just the area | want?

There are Set Points you can use to determine the area where the Maestro should place your
music. Drag the play indicator to the starting point and choose Set Start Point from the
Soundtrack menu. Then drag the play indicator to the location where you want the music to
end, and choose Set End Point from the Soundtrack menu. Then click the Add Music button
to score just that area of your Timeline.

--- How do | work with applications other than iMovie and iPhoto?

You can import any movie file that is compatible with QuickTime into Movie Maestro. Just
export a low-quality reference movie from your video editing program, then open it in Movie
Maestro. See the Movie Import chapter for more details. When you have completed the music
for the movie, save your soundtrack using either the "Complete Soundtrack” or "Each Smart
Block in a separate file" options (see the Saving chapter for more details).. You'll then have

sound files that can be imported into your video editing system for use with your movie.

--- Why are the soundtrack variations sometimes a slightly different
length than | specify?

When Movie Maestro creates a soundtrack for you, it knows how to do professional edits to the
music. Movie Maestro always generates an arrangement that is musically accurate. We have
built into the program the time flexibility of up to 1/2 second; that is, the Smart Block is allowed
to be up to 1/2 second shorter or longer than the time length requested. This is done to allow
for more possibilities of variations of the music. Movie Maestro may only be able to generate
one piece of music for a given time length, but may be able to generate several variations when
given a slightly larger time window. Try out different variations of the music to see which one
works best with your movie.


http://www.smartsound.com/sonicfire

Troubleshooting

Below are some common technical problems and their solutions. You can also visit our special
Frequently Asked Questions web page.

« How can | find out about updates to Movie Maestro?

--- How can | find out about updates to my Movie Maestro program?

If you registered your Movie Maestro software you will be automatically notified by e-mail when
updates are released.

You can also check http://www.smartsound.com for the latest information, helpful hints, FAQs,
and updates (if necessary).



http://www.smartsound.com/redirect.pl?app,mm&location,support
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Technical Support

If you have a problem or question not addressed elsewhere in the manual, visit the Frequently
Asked Questions web page. The latest information, helpful hints, frequently asked questions
(FAQs), and updates (if necessary) are available there.

Registered users of SmartSound Movie Maestro may also contact our Technical Support
department. There is a support form at the web site which will email our Technical Support
department. There is no charge for this service. If you have not registered your software, visit
www.smartsound.com/reg.
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Glossary

Following are definitions of some common terms used throughout the Movie Maestro program
and throughout the documentation:

Block Volume - This is the volume setting of an individual Smart Block on the Timeline. Each
block can have a different volume level, if desired. Just select the block on the Timeline (by
clicking on it with the mouse) then dragging the block volume bar to the desired volume level.

Frames - A unit of measurement for a movie; each frame represents one shot of the movie.
Frames are played at up to 30 frames per second to make up a moving picture. Movie Maestro
displays time lengths including frames, for precise editing.

Librarian - A setup area in Movie Maestro where you can add new SmartSound music CDs, as
well as copy the music to your hard drive (so that the CD is not required when you use the
program).

Library - One CD of SmartSound music. Each CD, or Palette, has music that has been
specially formatted to work with our Movie Maestro program. The music on each SmartSound
library contains special encoding which tells Movie Maestro how to edit the music professionally
to the time length you need. Libraries that are designed to work with Movie Maestro are called
Movie Music CDs, and are priced for home use. Other SmartSound CDs are Audio Palettes,
Sound Palettes, and The Edge Series, with music designed for commercial use. All
SmartSound music works with Movie Maestro.

Maestro - Located by clicking the Add Music button, the Maestro helps you find the right piece
of music for your movie, and adds the music to the Timeline.

Movie Music -A line of CDs specially created for users of Movie Maestro with the home and
educational user in mind. The CDs each have 10 selections of music that fit into one of six
categories: Vacation, Family, Blockbuster, Cutting Edge, Sentimental and Sports. The Movie
Music CDs have a lower price, with licensing defined for home and educational use only.

Movie Volume - This is the volume setting for the movie you open in Movie Maestro. When
watching the movie, you may want to adjust the volume of any existing audio, such as
narration. Just drag the movie volume lower to decrease volume, or higher to increase volume.
Since the movie you open in Movie Maestro is likely a temporary reference movie, additional
volume adjustments may be necessary in your video editing system before you create your
final movie.

Project - Work you have done within Movie Maestro can be saved as a Movie Maestro project.
Projects are helpful if you need to save your work to finish at a later time, or if you might want to
make changes in the future. Projects are saved with your movie (if one is opened) along with
any music you have added to the Timeline.

Resizer- The points at the beginning and ending of each Smart Block on the Timeline. Resizers



can be dragged to change the length of the block; when dragged, Movie Maestro automatically
reedits the music to create new, professional arrangements of the music for the new time
length of the block.

Scoring - The process of adding music to a movie.

Smart Block - Music that has been added to the Timeline by using the Add Music button. The
blocks are "Smart", since they can be changed to any time length and automatically reedited to
accommodate the change in length. Smart Blocks also are able to create different
arrangements of the music, to allow for alternate variations of the music to fit individual music
tastes.

Soundtrack - The complete musical score for your movie. The soundtrack can consist of one
or multiple pieces of music.

Source - The original piece of music, from which new arrangements can be generated through
the Movie Maestro process.

Timecode - Set in minutes, seconds, and frames format (MM:SS:FF). The timecode is used to
line up the soundtrack to match the exact point in your movie so that the music syncs to the
movie.

Timeline - The area at the bottom of Movie Maestro where the music blocks are placed.

Track Volume - The volume setting for the soundtrack on the Timeline. This volume setting
changes the volume of all blocks on the Timeline. Drag the volume bar down to decrease the
volume.

Variation - When Movie Maestro creates a Smart Block, it attempts to create as many
variations of the music as possible. Alternate variations consist of the same piece of music,
rearranged to the same time length, but sounding slightly different. The number of variations
available vary depending upon the time length of the block, as well as the complexity of the
source piece of music selected.
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